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ABSTRACT 

 

Modelling the Structure of Maize Starch Branching Enzyme IIb and Effects 

of Serine Phosphorylation Using Bioinformatics 

 

 

 

Anjali Silva                                                                                                                         Advisors: 

University of Guelph, 2013                                                                                  Dr. Michael Emes 

  Dr. Sanjeena Dang 

 

 

Amylopectin biosynthesis involves several classes of interacting enzymes regulated by 

post-translational modifications. In 2004, Tetlow et al. identified a multi-enzyme complex, 

consisting of Starch Synthase I, Starch Synthase IIa, and Starch Branching Enzyme IIb (SBEIIb), 

involved in amylopectin synthesis. The assembly of this trimer is phosphorylation dependent, 

with SBEIIb known to be phosphorylated at Serine 286, 297 and 649. Currently, the 

crystallographic structure of SBEIIb is not known. This project focused on using bioinformatics 

tools to make predictions about Maize SBEIIb: its structure, effects of serine phosphorylation, 

putative phosphorylation sites, and corresponding kinases. The SBEIIb structure was identified 

using homology, ab initio, and threading/ fold recognition tools. Across all tools, the core region 

of the predicted structure agreed, but the N-termius highly varied. Serine 286, 297 and 649 were 

found to localize on free loops. Phosphorylation was carried out using SYBYL-X 1.3 suite 

(SYBYL, Tripos Associates, St. Louis, MO), and molecular dynamics simulations were started 

on GROMACS 4.5.5 software package. Findings from this project widened current 

understanding about amylopectin biosynthesis.  
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Introduction 

1.1 Starch, Granule Structure and Amylopectin 

 

The world faces a serious challenge with maintaining the food supply to over 7 billion 

people
3
. By 2050, this number is expected to rise to 9 billion

3
. According to the Food and 

Agriculture Organization (FAO) of the United Nations, 90 percent of the world's food intake is 

provided by crop plants
26,27

. Maize, wheat, and rice make up two-thirds of this 90 percent
26,27

.  

Starch is vital to these plants as it makes up the highest proportion of plant carbohydrate 

reservoir
7
. Despite the vast amount of data available on starch, understanding how starch is 

synthesized is a challenge
1,2,6,7

. This is because biosynthesising the highly ordered structure of 

starch is a complex process involving several classes of interacting enzymes which are regulated 

by post-translational modifications
5
. A multidisciplinary approach is needed to decipher these 

mechanisms
8
. One potential method is to combine biochemical studies with bioinformatics.  

 In higher plants, starch is stored in granules within platids: amyloplasts for starch storage 

and chloroplasts for transient starch
8,22

. Starch is made up of two glucose polymers, amylose and 

amylopectin
2,8

. The semi-crystalline structure of a starch granule is 75% amylopectin by mass 

and rest is amylose
1,2,8

. Amylose is synthesized by granule-bound starch synthase, known as the 

waxy protein
10,13,14

. Despite lacking amylose, waxy mutants do not show significant differences 

from normal starch granules
10,12,13,14

.  Thus, amylose is not considered vital for the formation of 

functional starch granules
5
. In contrast, amylopectin is important to the structure of the starch 

granule due to its the semi-crystalline properties and the frequency of α-1,6 branches
5,8,9,17,18

.  

 

1.2 Formation of Protein Complexes in Starch Biosynthesis 

Synthesis of amylopectin requires several enzymes including starch synthases (SS), 

starch branching enzymes (SBE), debranching enzymes (DBE), starch phosphorylase (SP), 

isoamylases (ISA), pullulanase, and disproportionating enzyme
5,7

. Several genetic and 

biochemical studies have shown that these enzymes do not work in isolation but interact
5, 

19,20,21,43,44
. For example, the amylose extender (ae

-
) mutant, which lack SBEIIb, leads to reduced 

activity of SSI in maize and rice
5,19,20

. The dull mutant, resulting from loss of SSIII function in 

maize, decreases the activity of SBEIIa and SSII
5,21

. Existence of protein interactions were 

strengthened by studies across plants which showed that loss of SSIIa leads to loss of SSI, 

SBEIIa and SBEIIb in starch granules
5
. In 2004, Tetlow et al. identified a multi-enzyme 
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complex, composed of SSI, SSIIa and SBEII, in amyloplasts of the developing wheat endosperm 

10-15 days after pollination (DAP)
5,23

. Studies suggested that SSIIa is the central component of 

the trimer
5,23,24

.  This complex was not present in early developmental stages, despite the 

presence of each individual enzyme
23,44

. Therefore, data suggests presence of developmentally 

regulated interactions between SSs and SBEs
23

.   

 

1.3 Phosphorylation in Complex Formation  

  

Recent research shows that the fine control of starch metabolic pathway is achieved 

through post-translational modifications in addition to transcriptional control mechanisms
5,8,32

. 

Phosphorylation has been shown to regulate physical interactions between SBE and SSs
23,44

. In 

2004, Tetlow et al. discovered that phosphorylation activates SBEIIa in amyloplasts and 

chloroplasts, and SBEIIb in amyloplasts, while dephosphorylation reduces their activity
22

. In 

2006, Alexander and Morris discovered that SSI, SSII, and SBEIIa bind to amyloplast 14-3-3 in 

a phosphorylation dependent manner, which suggested that SS-SBEII complex form via 

phosphorylation
23,66

. It is believed SSI and SSIIa form the core of the trimer, followed by 

recruitment of SBEII
23,24,44

. In 2008, Tetlow et al. identified that interactions between SS and 

SBE, observed 10-15 DAP, were not present in APase incubated plastid lysate. Thus, suggested 

that nonspecific dephosphorylation may have lead to their dissociation
23

. Therefore, results 

provided evidence for phosphorylation regulated enzyme assembly.  

Regulation of protein complex formation by phosphorylation suggests involvement of 

protein kinases
5
. Various kinases have been discovered as potential candidates for plastid 

localization
25,76,77,78

. In 1992, Dreier et al. suggested possible involvement of calcium-

calmodulin-dependent protein kinases in regulation of SS
5
. Later studies using Solanum and 

Arabidopsis implicated involvement of SNF1-related protein kinase (SnRK1) in the pathway that 

activates ADP-glucose pyrophosphorylase, which regulates starch biosynthesis
78,80,81,82

. In 2007, 

Kempa et al. identified a kinase from Medicago sativa, MsK4, which localized in starch granules 

of plastids at different developmental stages
5,76

. MsK4 shows 85% sequence similarity to AtK-1 

(A.thaliana kinase 1), 50% identity to GSK-3 (glycogen synthase kinase 3), and Drosophila 

SHAGGY kinases
76

. In 2012, Bayer et al. identified a chloroplast localized ABC-1 like kinase 3 

(ABC1K3). Its mutation leads to chloroplasts with few visible starch granules, suggesting a role in 

starch accretion. Novel plastidial kinase candidates of starch biosynthesis remain to be explored. 
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1.4 Known Three Dimensional Structures and Starch Branching Enzyme IIb 

Glycogen biosynthesis in animals is similar to starch synthesis in plants. However, 

glycogen synthesis only requires one glycogen synthase and one branching enzyme (BE)
44

. In 

2002, the x-ray crystallographic structure of the E.coli BE was determined. This enzyme contains 

3 domains:  a seven-stranded beta-sandwich domain toward the NH2-terminal, a COOH-terminal 

domain, and a central alpha/beta-barrel domain, which act as the active site
49

. Recently, the 

crystal structure of BEI from Oryza sativa L without the C-terminus was identified by Noguchi 

et al., 2011
54,55

. This was done though molecular replacement using the E.coli BEI
54

.  

The structure of mature Rice BEI was ellipsoidal in shape
54

. The first 1-58 residues form 

the N-terminus alpha helix, which has no known sequence motif
54

. Residues 59-160 forms a 

carbohydrate-binding module 48, residues 161-587 forms the central (β/α)8 catalytic region, and 

residues 588–702 form α-amylase C-domain
54

. The structure of rice BEI was determined by 

combining structures of 3AMK and 3AML (Appendix A for structures)
54

. The 3AMK is the 

refined model of BE core domain, which contains 675 residues
54

. The loop regions between 

Glutamine (GLN) 469 and Glycine 473, Proline 664 and Asparagine (ASN) 672, five N-terminus 

residues, and 8 C-terminus residues of 3AMK had weak density
54

. BEI was also overproduced as 

a fusion protein with a glutathione S-transferase (GST) sequence as its N-terminus
54

. The 

cleaved protein is called 3AML
54

. No electron density was visible for the first 6 N-terminal 

residues and 56 C-terminal residues, thus 3AML contains 693 residues
54

. Structural alignment 

showed minimal differences between 3AMK and 3AML.  

BEII is important for amylopectin synthesis as it transfers shorter glucan chains and show 

higher affinity toward amylopectin
8,67,68

. In contrast, BEI transfers longer glucan chains with 

higher affinity toward amylose
8,67,68

. The C-termini of BEI and BEII are vital for substrate 

selection, and N-termini for the length of the glucan chain transferred
8,70

. Maize BEI and BEII 

sequence alignment gives an identity of 58%. When functionally similar amino acids are 

accounted, the identity increases to 67%
70

. BEIIb is the most abundant protein in the maize 

amyloplast stroma and the predominant isoform of BEII in the endosperm
24,72

. The mature 

protein has 738 residues, as the 61 residue N-terminal transit-peptide is cleaved upon localization 

to the amyloplast or chloroplast. In ae
- 
mutation (lack of BEIIb), the SSI-SSIIa-SBEIIb trimer is 

lost and novel interactions are found
24

. This leads to altered amylopectin structure 
24,73-75

. Thus, 

BEIIb is vital for protein complex formation and normal starch phenotype. Maize BEIIb is 
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known to be phosphorylated at Serine 286, 297 and 649. Maize BEIIb is known to interact with 

SSIIa at the KCRR domain, which is located between residues 662-665.    

 

1.5 Unknowns, Bioinformatics and Objectives 

Knowledge about post-translational regulatory mechanisms in starch biosynthesis and 

their impact on granule structure can be highly beneficial to production of novel starches with 

enhanced functionalities. However, the exact mechanisms of how enzymes form complexes, 

precise interacting domains, and effects of phosphorylation on structure remain unclear to date. 

Only few crystallographic structures of starch biosynthesizing enzymes are currently available. 

Phosphorylation is known to occur on Serine and Threonine residues. However, only few sites 

have been confirmed. Others remain to be explored along with kinases involved
5,22-24

.  

Bioinformatics, in general terms, is defined as the development of computational tools to 

organize biological data. Analysis of biological data using existing computational tools falls 

under the field of computational biology
4
. Some considers bioinformatics to encompass all of 

computational biology, while others consider they are separate fields
4
. Bioinformatics holds 

great potential to find above stated unknowns through predictions based on known data. Such 

discoveries can be used for hypothesis generation and experimentation to confirm their validity. 

The main objective of this study was to use bioinformatics to predict the effects of 

phosphorylation on starch biosynthesizing enzymes and their interactions. Due to time 

constraints, the project focused on SBEIIb. The study was divided into 3 stages. The first stage 

involved modelling the three-dimensional (3D) structure of SBEIIb. The second stage involved 

identifying the effects of phosphorylation on the structure. The third stage involved predicting 

putative phosphorylation sites of SBEIIb and potential kinases. Attention was paid to algorithms 

and statistical frameworks of the computational tools that were used to accomplish these goals.   

 

2  Stage I - Modelling Structure of Maize Starch Branching Enzyme IIb 

2.1 Experimental Design  

Initially, the sequence and structural homologs of mature maize SBEIIb were identified 

using Blastp
16

 of NCBI and TM-align program
15

, respectively. Next, a literature survey was 

carried out to identify 3D protein modelling tools. Ideal tools were recognized as those which 

generate the 3D structure of a protein upon amino acid sequence submission. CPHmodels
85-86

, 
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ESyPred3D
87

 and SWISS-MODEL
88

 Workspace were identified as homology modeling tools, 

which predict the protein structure based on known structures of homologs
84

. Ab initio modelling 

uses force field information to calculate the energy of a conformation, and thereby the structure 

without prior details on folds
84

. Robetta Beta
89

 was identified as a tool that uses both homology 

and ab initio modelling. Threading involves fitting the target sequence to known protein folds to 

select most energetically and stereochemically favourable folds
84

. Threading or fold recognition 

tools included I-Tasser
90

 and Phyre 2.0
91-92

. Protein modeling was carried out using all six tools. 

Sequence alignment was done using MAFFT, Tcoffee-EBI, and ClustalW
11

. Upon visual 

inspection in PyMOL
60

, I-Tasser model was chosen for phosphorylation simulations.  

 

2.2 Results and Discussions 

According to Blastp output, BEI of rice had 86% identity to mature maize SBEIIb. Two 

other predicted proteins with unresolved structures from S. bicolour and S. italica had higher 

scores (Table 1, Appendix A for alignment). Since proteins with similar sequences do not always 

have similar structures, best structural analogs of maize BEIIb were identified using TM-align 

program. Rice BEI was identified as the top structural homolog with a TM-score of 0.904 (Table 

2, Appendix A for alignment and structures). The TM-score is a scale for measuring the 

structural similarity between two proteins, with a score >0.5 indicating a model of correct 

topology and a score <0.17 indicating random similarity. Thus, a score of 0.904 indicated that 

structures of maize BEIIb and rice BEI align well. From all the results, rice BEI was the only 

protein that was identified as both a structural and a sequence homolog of maize BEIIb, and also 

had its structure resolved.  

The maize BEIIb structure modeled by CPHmodels, ESyPred3D and SWISS-MODEL 

Workspace began from residues 54 or 56 of the mature protein sequence (Figure 1). In contrast, 

Robetta Beta, I-Tasser, and Phyre 2.0 models began from the first residue. All models ended at 

residue 736. The Oryza sativa BEI structure 3AML was chosen as the main template across all 

tools, except by I-Tasser. In I-Tasser, 3AMK was the top template, while 3AML was the top 

structural analog. The core region and the C-termini of models generated by the six tools agreed 

and aligned (Figure 2). However, the N-termini modeled by Robetta Beta, I-Tasser, and Phyre 

2.0 was a highly disordered loop/ an α-helix and did not align (Figure 3). Alignment showed that 

the first 55 residues of maize BEIIb and rice BEI sequence do not align (Figure 6, Appendix A). 
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Poor alignment likely led the programs to model these 55 residues differently. Due to the high 

variability, first 55 residues were removed from further analyses. 

The model by I-Tasser was chosen to carry out phosphorylation and final simulations. 

This was due to three reasons. All tools chose rice BEI as the main template, thus selection was 

not limited by template availability. I-Tasser stood out among other tools as it is highly ranked 

for protein structure prediction by Critical Assessment of Techniques for Protein Structure 

Prediction (CASP) experiments
94

. I-TASSER has ranked first in CASP10, 9, 8, and 7
93,94

. Also, 

I-Tasser permits the user to exclude or include a template of choice, in addition those chosen by 

its algorithm. I-Tasser program works by first predicting the 2
°
 structure of the submitted amino 

acid sequence using machine learning
40

 (Figure 4). Then the sequence and the 2
°
 structure are 

matched with resolved structures in the PDB library to identify best templates
40

. This threading 

process is done using LOMETS algorithm
40

. In the second step, the templates are split into 

fragments based on sequence template alignments
40

. Then the fragments are reassembled into 

full length models, called cluster centroids
40

. Unaligned regions are built by ab initio modeling
40

. 

In the third step, full atomic models are constructed by atomic level refinements using REMO 

algorithm, which optimize hydrogen bonding networks and minimize steric clashes 
40

.  

The final maize BEIIb structure from I-Tasser was derived by specifying 3AML as a 

template because only 3AMK was chosen by default. The final model had 683 residues with the 

N-terminus removed (Figure 5A). The final and default models aligned well, except at residues 

106-109, 124-130, 167-175,181-183 of the default model (Figure 5B). These regions appeared as 

beta-strands in the default model, but as anti-parallel loops in the final model (Figure 5C, D). 

The regions were verified using VMD, a molecular visualization program like PyMOL (Figure 

7). It was hypothesized that the alteration was due to lack of N-terminus in the final model. The 

N-terminus of the default model likely had hydrophobic contacts with the beta sheet region 

(circled, Figure 5B). In order to stabilize these contacts, the default model may have had more 

beta sheets. However, it should be noted that the final structure lack only minimal requirements 

to form beta sheets. The backbone was not drastically altered as anti-parallel loops were present.  
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3  Stage II - Identifying Effects of Phosphorylation on Maize SBEIIb 

3.1 Experimental Design 

Known phosphorylation sites and KCRR interaction domain were identified on the final 

model using PyMOL. The sites were visualized using surface charge models and electrostatic 

contact potential models to identify solvent accessibility and charge of residues, respectively. 

Structure analysis and phosphate addition were performed using SYBYL-X 1.3 molecular 

modeling suite (SYBYL, Tripos Associates, St. Louis, MO). Structure analysis involved chain 

termini fixation, and side chain amide orientation in all ASN and GLN residues to maximize 

hydrogen bonding (Appendix B for commands). The PO4
2-

 groups were added to hydroxyl 

oxygen in the side chains of S286 and S297 residues (Appendix B). Four models were 

considered: (i) non-phosphorylated as the control; (ii) singly-phosphorylated at S286 (pS286); 

(iii) singly-phosphorylated at S297 (pS297); and (iv) doubly-phosphorylated at S286 and S297 

(pS286- pS297). Simulations were carried out using SYBYL-X 1.3 and GROMACS 4.5.5
96

. 

Within SYBYL-X 1.3, hydrogens were added to models in a random orientation (default 

setting specificed in the manual). Local minimization involves relaxing the strain of a subset of 

residues. Local minimization was carried out on each model using the AMBER7 FF99 Force 

Field and Amber charges. For localized minimization, the phosphorylated residue(s) was 

selected as the subset. Torsional minimization was carried out to remove cluttered starting 

geometries and to optimize side chain geometries. Molecular dynamics (MD) is the process of 

studying conformational freedom of a protein at equilibrium (near lowest energy state)
100

. This is 

done using mathematical equations of motion and a potential energy function for the system and 

its associated force field
99

. For mature Maize SBEIIb, 1000 femtosecond (0.001 ns, default 

settings of SYBYL) MD simulations were carried out at 25 °C, which is an approximation of the 

average temperature at which Maize grow, with AMBER7 FF99 Force Field and Amber charges. 

Total energy and charge were calculated before and after simulations for each model. 

Within GROMACS 4.5.5, Gromos96 ffG53a6 force-field
97

 was used for MD simulations 

in SHARCNET high performance computer cluster (www.sharcnet.ca, Appendix C for 

commands).  Each model (control, pS286, 297, 286+297) was centered in a cubic virtual box and 

was placed 1 nm from the box edge. The box was solvated with water molecules using an 

equilibrated 3-point solvent model spc216
50,98

. The final density of the system was 

approximately 1037.7 g/L. The net charge of the protein was neutralized by adding Na
+
 and Cl

-
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counter-ions. A salt concentration of 0.15 M was included for 2 reasons:  this is the standard 

level used in experiments to mimic plant cellular salt conconcentration
64

 and salt bridge 

formation is common upon phosphorylation (Appendix C). The system was energy-minimized to 

a maximum overall force of <1,000 kJ/mol/nm. This was done using the steepest descent 

minimization algorithm with the rcoulomb and rvdv cut-offs set at 1.2 nm. Carbon bonded 

hydrogens, which do not participate in hydrogen bonding, were ignored for faster simulation 

time. Equilibration of solvent and ions around the protein was carried out at 1 atm, using 

Berendsen isotropic pressure coupling and velocity rescaling with a stochastic term (v-rescale) 

thermostat for temperature coupling, at 25°C
41

. MD time step (dt) was set to 0.002 ps, and the 

same pre-equilibration settings were used with respect to temperature and pressure couplings. 

The equilibrated system is planned to be simulated for total of 50 ns. 

   

3.2 Results and Discussions 

The three known phosphorylation sites, S286, S297, S649, and the KCRR domain were 

localized on free loops within the final I-Tasser model (Figure 8A, D, G, J). Comparison with 

structures from other modeling tools showed alignment at these locations. Thus, across all the 

models, S286, S297, S649, and the KCRR domain were located on loops. Interestingly, KCRR 

domain lied closer to S297 based on the 3D model, as opposed to in the linear amino acid 

sequence, where KCRR domain lies closer to S649 (Figure 8J). Based on this observation, it was 

hypothesized that phosphorylation of S297 will likely affect the KCRR domain and thereby 

protein-protein interactions. According to surface charge models, all three sites and the KCRR 

domain were solvent accessible and not buried within the structure (i.e. the yellow and green 

colours are visible on the model, Figure 8B, E, H, K). Due to localization on surface loops, 

phosphoserines will be well hydrated with water. Thus, structural perturbations upon adding a 

phosphate group will likely be minimal. According to electrostatic contact potential models, 

S286 was surrounded by positively charged residues, S297 was surrounded by negatively 

charged residues, and S649 and the KCRR domain were surrounded by both positively and 

negatively charged residues. The positively charged residues surrounding phosphoserines will 

stabilize the phosphate group upon attachment. Serine 298 was predicted as a possible 

phosphorylation site as it is surrounded by positively charged residues and localized within a 
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loop.  Based on these observations and due to localization within 11 residues apart, the two 

known phosphorylation sites, S286 and S297, were chosen for simulation analysis. 

Before energy minimization in Sybyl-X, the control model had a total charge of -22 and a 

total energy of 437631.2 kcals/mol. After minimization, total energy was approximately halved 

to 203274.5 kcals/mol. After MD, total energy was decreased by approximately 7 times to 

27591.119 kcals/mol. For pS286, total charge was -22.428 and the initial energy was 1791527.2 

kcals/mol. The total energy decreased to 423250.3 kcals/mol and 14781.947 kcals/mol, after 

minimization and MD, respectively. The charge of pS297 was same as pS286, but its initial 

energy was lesser, 1617078674.4 kcals/mol.  The total energy decreased to 214560 kcals/mol 

and 15695.2 kcals/mol, after minimization and MD, respectively. Finally, the pS286+297 had a 

charge of -22.9 and an initial energy of 1618435669.9 kcals/mol.  The total energy decreased to 

203274.5 kcals/mol and 17020.4 kcals/mol, after minimization and MD, respectively.  

Orientation of positively charged residues surrounding S286 and S297 were identified on 

the control structure that underwent local and torsion minimization, followed by molecular 

dynamics in SYBYL (local minimization-MD). Serine 286 was surrounded by Lysine 285 

(K285), and Arginine 288 (R288, Figure 9A). Serine 286 side chain pointed toward the side 

chain of Methionine 697 (M697). Upon phosphorylation of S286, visual analysis reveled that 

side chains of S286 and M697 were near clashing (not shown). However, upon local 

minimization-MD of pS286 structure, the phosphate group on S286 pointed away from M697 

(Figure 9D). When the structure of pS286 was compared to control structure, K285 side chain 

pointed away from S286 phosphate group on the pS286 structure. This is opposed to the 

expected outcome, whereby K285 would point toward pS286 to stabilize the negative charge of 

the phosphate group. An alternative explanation might be that the loop containing S286 may 

have altered due to addition of the bulky phosphate group, which lead the K285 to point away 

from pS286. Serine 297 was surrounded by K302, R310 and R316 (Figure 9B). Upon 

phosphorylation and local minimization-MD, a change was observed in the α-helix near Valine 

307 (V307, Figure 9E – yellow arrow). It is not clear whether this is an optical illusion. This 

change was not observed in the doubly phosphorylated, locally minimized-MD structure (Figure 

9G). Overall, observable changes were not present in the KCRR domain (green loop, Figure 9) in 

singly phosphorylated structures and doubly phosphorylated structure in comparison to control.  
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Within Sybyl-X, local minimization-MD was carried out in an isolated system (In Vacuo 

simulation), which is the default setting. This is the least computationally expensive approach 

and involves using a screening term in the force field, which allow simulate solvent screening 

effects on electrostatic charges
99

. In contrast to Sybyl-X, GROMACS simulations were carried 

out in an explicit solvation system (Figure 10). Explicit solvation is the most accurate and a 

computationally expensive method
99

. It is vital for a system where the solvent interacts with the 

solute, for example by forming hydrogen bonds. It should be noted that Sybyl-X offers explicit 

solvation options, but due to the time constraints of the project, these were not used. Further, MD 

simulations in Sybyl-X were done within an interval of 1000 femtoseconds, which is the default 

setting. In contrast, MD simulations in GROMACS are much longer, with the interval set to 50 

nanoseconds. Within GROMACS, each structure was added with counter ions to neutralize the 

charge and the protein was equilibrated at an appropriate temperature (25 °C) and pressure (1 

atm) prior to MD. These steps were not included in the Sybyl-X (Force field manual, SYBYL-X 

1.3). Additionally, global energy minimization was performed on GROMACS, where as local 

energy minimization was performed on Sybyl-X simulations. This was because upon global 

minimization in Sybyl-X, the secondary structure of the protein fell apart. Overall, for this 

project, GROMACS will provide results that are closer to true dynamics of the protein, 

compared to Sybyl -X. 

Energy minimized, phosphorylated structures from GROMACS did not reveal any 

significant/ observable changes in the protein structure relative to the control (Figure 11). The 

orientation of the KCRR domain did alter upon phosphorylation of both S286+297, compared to 

singly phosphorylated residues (in green, Figure 11). The total energy of the control structure 

went from -1550000 kJ/mol to -2500000kJ/mol and stayed at this energy over an approximate 

time frame of 1131 ps (Figure 12). Upon equilibration, phosphate groups on Serine side chains 

had slightly altered orientation. However, no significant changes were observable, including at 

the KCRR domain. MD results of GROMACS are in progress, and may reveal significant effect 

due to phosphorylation, if any will be present. A trajectory of the conformational changes to the 

protein at equilibrium will be produced upon completion of MD. Favourable conformations of 

the proteins can be identified by analyzing the time length of each conformation, as favourable 

conformations occur for a longer timeframe compared to less favourable conformations.   
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4  Stage III - Predicting Putative Phosphorylation Sites of Maize SBEIIb and 

Protein Kinase Candidates 

4.1 Experimental Design  

A literature survey was used to identify computational tools for predicting phosphorylation sites. 

Ideal programs were recognized as those which generate putative phosphorylation sites with 

prediction scores, and kinase candidates upon submitting the amino acid sequence. Such tools 

included NetPhos2.0
35

, NetPhosK1.0
36

, KinasePhos2.0
34

, Group-based Prediction System (GPS) 

2.1
33

, and DISorder‐enhanced PHOSphorylation predictor (DISPHOS1.3)
31

. All tools, except 

NetPhos 2.0 and DISPHOS1.3, provided kinase-specific predictions. Each tool was analyzed and 

default settings were used for predictions. Sites identified across at least 3 out of the 5 tools were 

separated and significance was determined based on score. Sites with at least 3 significant scores 

were visualized on the 3D model. Known sites predicted by the tools were analyzed separately. 

Kinase candidates of significantly scored sites were identified. For mammalian and yeast 

kinases, plant homolgos were determined using TAIR and NCBI Blast
62

. Kinases selected based 

on localization were analyzed for expression stages, tissue types and starch related functions.  

 

4.2 Results and Discussions 

NetPhos2.0 predictions are done using an artificial neural network
35

. A database of 

experimentally validated phosphorylation sites, PhosphoBase, is used to identify features of the 

sequences surrounding the phosphoresidues
35

. Phylogenetics trees are constructed to identify 

relationships between input and database sequences
35

. Neural networks based on structure data 

from PDB are used to predict α-carbon contact maps for putative sites
35

. Sites are evaluated and 

predictions are provided. Similarly, NetPhosK1.0 uses neural network to predict kinase-specific 

phosphoylation sites of eukaryotes
36

. KinasePhos2.0 uses Phospho.ELM and Swiss-Prot 

databases to determine catalytic kinase-specific phosphorylation sites
34

. The sequence and 

coupling pattern of surrounding catalytic sites are used to train support vector machine (SVM) 

model
34

. Following cross validation, parameters of the trained models are optimized to maximize 

the prediction accuracy
34

. Finally, the parameters with the highest accuracy in each data set are 

chosen
34

. GPS2.1 uses data from Phospho.ELM
33

. The algorithm of GPS2.1 for scoring 

phosphorylation was developed based on the hypothesis that two short sequences with high 

sequence homology may have similar structure and properties
33

. To improve robustness and 
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stability of results, the specificity is fixed to 90%
33

. Various threshold levels are specified by 

GPS2.1 for different kinase groups
33

. DISPHOS1.3 was constructed using data from SwissProt 

R44, Phospho.ELM database, and literature
31

. DISPHOS1.3 algorithm relies on the observation 

that residue composition, sequence complexity, hydrophobicity, and residue charges next to 

phosphorylation sites are similar to sequence attributes of intrinsically disordered protein 

regions
31

. As a result, the level of disorder is used to discrimination among phosphorylated and 

non-phosphorylated sites
31

. Scoring method and settings of each tool is summarized on Table 3.  

Predicted Serine and Threonine sites identified across at least 3 out of the 5 tools were 

separated (Table 4). A total of 16 out of 47 Serine sites, and 2 out of 31 Threonine sites in the 

mature SBEIIb sequence were predicted. Within these results, sites with at least 3 significant 

scores across all tools were recognized (bolded, Table 5). A total of 9 such sites, 8 Serine (S) and 

1 Threonine (T), were identified. These included S77, 82, 91, 147, 160, 204, 239, 705 and T94. 

Sites S147, S91, S77, and S160 received significant scores across all tools.  Localization of 

S147, S160, S204, S239, and S705 were visualized on the final model from I-Tasser.  

Localization of S77, S82, S91, and T94 were visualized using the default I-Tasser model, as 116 

residues from N-terminus were removed in the final model. Sites S77, S82, S91, T94, and S239 

were located in free loops (Figure 14F). It should be noted that S77, 82, 91, and T94 were all 

located in one loop which formed the highly disordered N-terminus of Maize SBEIIb. Sites 

S147, S160 were located in α-helices, and S204, S705 were located in β-sheets (Figure 14A). All 

predicted sites were solvent accessible based on surface charge models (Figure 14C, E, H). 

According to electrostatic contact potential models, T94, S147, S204, and S239 were surrounded 

with both positively and negatively charged residues. S160 was surrounded with only positive 

residues, and S77, S82, S91, S705 were surrounded with only negative residues. Based on these 

findings, S160 is a probable candidate for phosphorylation as it is solvent accessible and 

surrounded by positively charged residues, which would stabilize a phosphate group upon 

attachment. Sites S147, S204, S239 and T94 are also likely candidates for phosphorylation.     

The three known sites (S286, 297, 649) were predicted across all tools (Table 5). Based 

on scores from GPS2.1 and DISPHOS1.3, S286 and 649 received significant scores. S297 did 

not receive a significant score from GPS2.1 as both the score and the cut-off value was at 6.5. 

The score for S297 from DISPHOS1.3 was below 0.5. All three sites received significant scores 

from KinasePhos2.0, NetPhosK1.0 and NetPhos2.0.  
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Based on putative kinase analysis, Casein kinase II (CKII) was the only kinase predicted 

across all programs (NetPhosK1.0, GPS2.1, and KinasePhos2.0) for the same site, S286. 

However, GPS2.1 score was not significant. CKII was also predicted to phosphorylate S86 and 

T34. In 2002, Ogrzewalla et al. identified CKII in the chloroplasts of mustard
28,29

. The crystal 

structure of CKII catalytic subunit from Zea mays was identified in 1998
30

. CKII is a tetramer 

formed by 2 alpha catalytic subunits and 2 beta regulatory subunits
29

. Salinas et al., 2006 found 

that all subunits of this kinase in A.thaliana were targeted to the cytosol or nucleus, except αcp 

subunit, which was targeted to the chloroplast. They also detected CKII activity in Arabidopsis 

chloroplasts. Ataxia telangiectasia mutated (ATM) kinase was predicted to phosphorylate the 

greatest number of sites, a total of 16 Serines including the 3 known sites. All predictions were  

derived from KinasePhos2.0. ATM is a human serine/ threonine kinase that phosphorylates 

proteins involved in cell cycle checkpoint. Its Arabidopsis homolog is a 3856 residue protein 

(AT3G48190) which is found in chloroplast, nucleus, and plasmodesma
62,63

.   

Protein Kinase A (PKA) was predicted to phosphorylate 6 Serine sites, including S286 

and S297. The Arabidopsis PKA, Root Hair Specific 3 (AT1G16440.1), was identified as being 

localized in chloroplast and plasma membrane
62

. Protein Kinase C and G (PKC and PKG) were 

found to phosphorylate 5 Serine sites each, including all 3 known sites. Calcium/calmodulin-

dependent protein kinase (CAMK) was predicted to phosphorylate 5 Serine sites, including 

S286. Homolog search identified SPK rice kinase, which is a CAMK expressed in the 

endosperm of immature seed. SPK has been proposed to be involved in starch biosynthetic 

pathway because antisense SPK transformants lack the ability to accumulate starch. However, 

the kinase is localized in the nucleus. Thus, it will not have direct contact with starch 

biosynthesizing enzymes
62

. GSK-3 was predicted to phosphorylate 3 Serine sites, including S297 

and 649. Homolog search identified the A. thaliana Shaggy-like kinase group 22 

(AT2G30980.1), which has been shown to localize in the chloroplast
62

.  

For phosphorylation site analysis, it should be noted that inconsistencies were present 

between results from different tools. For example, S82 received a very low probability (8%) of 

being phosphorylated from NetPhos2.0. However, NetPhosK1.0 yielded a significant probability 

(64%) for S82 phosphorylation with CKII as a candidate. Similarly, site S297 received a non 

significant score for phosphorylation by CKII from GPS2.1. However, the same site received 

significant scores for phosphorylation by CKII from KinasePhos2.0 and NetphosK1.0.  
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Figure 1: Structures of mature maize SBEIIb by CPHmodels (A), ESyPred3D (B), SWISS-

MODEL Workspace (C), Robetta Beta (D), Phyre 2.0 (E), and I-Tasser (F) visualized on 

PyMOL. The N-terminus of is shown in blue, and the C-terminus is in white. Note CPHmodels, 

ESyPred3D and SWISS-MODEL Workspace models began from 54 or 56
th

 residue the mature 

protein sequence, while Robetta Beta, I-Tasser, and Phyre 2.0 models began from the first 

residue.  

A B 

C D 

E 

F 

5 Figures and Tables 
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Figure 3: Alignment of mature maize SBEIIb 

structures from I-Tasser (yellow), Phyre 2.0 (red) 

and Robetta beta (orange) using PyMOL. The N-

terminus of I-Tasser is coloured in ‘slate’, Phyre 

2.0 model in ‘cyan’ and Robetta beta in 

‘purpleblue’.  

 

Figure 2: Alignment of mature maize 

SBEIIb structures derived from homology 

modelling using PyMOL: Swiss Workspace 

(magenta), ESyPred3D (cyan), CPHmodels 

(tv_green), and Robetta beta (orange).  

Figure 4: Schematic overview of 

the method used by I-TASSER to 

predict the three dimensional 

structure of a query sequence. N-

terminus of the proteins is blue, 

while the C-terminus of the 

proteins is red
91,92

. 

Figure 5: (A) The final structure of maize 

BEIIb by I-Tasser. (B) Alignment of default 

(yellow) and final (pale cyan) maize BEIIb 

derived from I-Tasser using PyMOL. The 

region circled indicates the unaligned region. 

(C) The circled region of the default model.  

(D) The circled region of the final model  

(beta sheets replaced by anti-parallel loops).  

B A 

C D 
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-Give the model by each method, scores and small explanation 

-the two rice BEI structures, talk about rice BEI alignment with SBEIIb, talk about how it is 

among top 10 homologs and structural analogs of starch BEIIb 

-why ignore first 55 amino acid residues  

-talk about how I-Tasser work: In I-TASSER server, the 3D models are built based on multiple-

threading alignments using LOMETS and iterative template fragment assembly simulations
94

. 

Next, the function insights are derived by matching the 3D models with BioLiP protein function 

database
94

. -final model by I-Tassser 

-known phosphorylation sites in the model, interaction domain 

 

 

 

 

 

 

 

 

Figure 6: Alignment of BEIIb sequence (3AML) from maize and BEI from rice
112

. Square in red shows the first 54 

residues from the N-terminus of BEIIb that do not align well with BEI. All other squares represent regions that 

showed poor alignment, other than at N-terminus. The known phosphorylation sites, pS286, 297 and 649 are labelled. 
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*TM-score is a scale for measuring the structural similarity between two proteins, with a score >0.5 indicating a model of correct topology and a score <0.17 indicating 

random similarity91,92.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

     

     

     

     

     

     

     

     

      

    

Table 1: Maize SBEIIb Homologs Determined by NCBI Blastp Upon Entering Mature Sequence  
 

Description                                                                                                                                  Structure    Query     Expect     Maximum 

                                                            Known      Cover*    Value**    Identity*** 

hypothetical protein SORBIDRAFT_04g021540 [Sorghum bicolor] >gb|EES06902.1|  (grass)  NO 100% 0 96% 

PREDICTED: 1,4-alpha-glucan-branching enzyme 2, chloroplastic/amyloplastic-like [Setaria italica]  NO 100% 0 92% 

rice starch branching enzyme I [Oryza sativa Japonica Group]  YES 94% 0 86% 

PREDICTED: 1,4-alpha-glucan-branching enzyme 2, chloroplastic/amyloplastic-like [Brachypodium 
distachyon] (grass)  NO 99% 0 84% 

starch branching enzyme IIb [Hordeum vulgare subsp. vulgare]  (Barley)  NO 97% 0 83% 

starch branching enzyme IIb [Triticum aestivum] (bread wheat)  NO 99% 0 82% 

PREDICTED: 1,4-alpha-glucan-branching enzyme 2, chloroplastic/amyloplastic-like [Glycine max] 

(soybean)  NO 93% 0 82% 

starch branching enzyme I [Pisum sativum] (pea)  NO 92% 0 82% 

1,4-alpha-glucan-branching enzyme 2, chloroplastic/amyloplastic [Aegilops tauschii] (grass type)  NO 100% 0 79% 

starch branching enzyme II, putative [Ricinus communis] (castor oil)  NO 99% 0 78% 
 

Protein input sequence is known as query sequence to a database of sequences is known as subject sequences. 

*Query coverage is the percent of the query sequence that overlaps with subject sequence95 

 **Expect value is the number of hits expected (closer to zero, more significant the match)95 
***Max. identity is the percent similarity between the query and subject sequences over the length of the coverage area95 

 

Figure 7: The final (in cyan) 

and default model (in yellow) 

of maize BEIIb as viewed on 

VMD
51

. Regions closer to the 

bottom of the figures indicated 

by arrows represent the area 

which appeared as beta-

strands in the default model, 

but as anti-parallel in final 

model.  

Table 2: Maize SBEIIb Structural Analogs as Identified by TM-align Programs 
 
 

PDB Hit    TM-Score*      Name (organism) 

 
 

3amlA 0.904 Structure of the Starch Branching Enzyme I (Oryza sativa L) 

3k1dA 0.772 Crystal structure of glycogen branching enzyme synonym: 1,4-alpha-D-glucan:1,4-alpha-D-GLUCAN 6-glucosyl-transferase from 

mycobacterium tuberculosis H37RV (Mycobacterium tuberculosis H37Rv) 

1m7xB 0.723 The X-ray Crystallographic Structure of Branching Enzyme (Escherichia coli) 

2ya0A 0.692 Catalytic module of the multi-modular glycogen-degrading pneumococcal virulence factor spua (Streptococcus pneumoniae TIGR4) 

2ya1A 0.691 Product complex of a multi-modular glycogen-degrading pneumococcal virulence factor spua (Streptococcus pneumoniae TIGR4) 

3fawA 0.688 Crystal Structure of the Group B Streptococcus Pullulanase SAP (Streptococcus agalactiae COH1) 

1bf2A 0.68 Structure of pseudomonas isoamylase (Pseudomonas amyloderamosa) 

2vr5B 0.674 Crystal structure of Trex from Sulfolobus Solfataricus in complex with acarbose intermediate and glucose (Sulfolobus solfataricus) 

2x4bA 0.673 Barley limit dextrinase in complex with beta-cyclodextrin (Hordeum vulgare) 

2fhbA 

 

 

0.669 Crystal Structure Analysis of Klebsiella pneumoniae pullulanase complexed with maltose (Enterobacter aerogenes) 
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S286 

A B C 

D E F 

G H I 

J K L 

Figure 8: The 3D model, surface charge models, and electrostatic contact potential model depicting S286 (A-C), 

S297 (D-F), S649 (G-I) and KCRR interacting domain (J-L), respectively of Maize SBEIIb. Within the 3D models 

and the surface charge models, the C-terminus is in magenta colour, the N-terminus is in red colour, the 

phosphorylation sites are in yellow colour, and the KCRR domain is shown in green. Within the electrostatic 

contact potential models, red indicates negatively charged residues and blue indicates positively charged residues. 
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Figure 9: Close-up (A, B, D, E, F,G) and whole (C, H) view of locally minimized-MD structures of Maize 

SBEIIb. Images A and B represent S286 and S297 of non-phosphorylated model, respectively. Image C 

represent the whole view of non-phosphorylated model. This non-phosphorylated, locally minimized-MD model 

served as the control.  Image D represents phosphorylated S286 of singly phosphorylated model pS286. Image E 

represents phosphorylated S297 of singly phosphorylated model pS297. The yellow arrow points to a region 

near V307 this model, where the α-helix has altered upon minimization-MD. Image F represents 

phosphorylated S286 of doubly phosphorylated model pS286 +297. Image G represents phosphorylated S297 of 

doubly phosphorylated model pS286 +297. Image H represents the whole view of doubly phosphorylated model 

pS286 +297. Across images, KCRR interaction domain is depicted in green colour.  

 

Figure 10: Close-up views of locally minimized-MD structures of Maize SBEIIb phosphorylated singly at S286 

(A) and singly at S297. The white arrow points to a region near M697, which has changed secondary structure 
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Figure 11: Gromacs energy minimized structures of non phosphorylated Maize SBEIIb  (A), phosphorylated 

at S286 (B), phosphorylated at S297 (C) and phosphosphorylated at both S286 and S297 (D).  Phosphoserines 

are shon in yellow, and KCRR domain in green (unable to produce element colours on VMD for .gro files).   

S286 
pS286 

pS286 

S286 

S297 
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A 

Figure 10: Gromacs simulation steps in blue and Sybyl-X simulation steps in white.  

Local Energy 
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Dynamics 
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Minimization 
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Figure 12: Gromacs energy vs time for Maize SBEIIb, non –phosphorylated (control). The starting 

energy is -1650000 kJ mol
-1 

and the final energy is -2500000 kJ mol
-1

.  

Figure 13: Gromacs equilibrated structures of non phosphorylated Maize SBEIIb  (A), phosphorylated at 

S286 (B), phosphorylated at S297 (C) and phosphorylated at both S286 and S297 (D).  Phosphoserines are 

shon in yellow, and KCRR domain in green (unable to produce element colours on VMD for .gro files).   

S286 

S297 

pS286 

S297 

pS286 

pS297 S286 
pS297 

B 

C D 

A 



22 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Table 3: Summary of Scoring Method and Settings of Phosphorylation Site Prediction Tools 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 14: The 3D models, surface charge models, and electrostatic contact potential models depicting 

predicted phosphorylation sites from left to right, respectively.  Models A-E represent sites located on 

the final model of I-Tasser: S147, S160, S204, S239, and S705. Models  F-H represent sites located on 

default model of I-Tasser: S77, S82, S91, and T94, due to their localization in the N-terminus.  

A 

B 
C 

D E 

F 
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NetPhos2.0 

 

[0-1], True sites obtain a score close to 1.0 and non-phosphorylation sites 
obtain close to 0.0. 

 

Predict on serine, 
threonine 

 

All  

NetPhosK1.0 [0-1], If higher chance the site is phosphorylated by the stated kinase, then 

a score close to 1.0. If lower chance of the site phosphorylated by the 
given kinase, then a score close to 0.0. 

Prediction without 

filtering (fast); 
Threshold 0.5 (default) 

All 

KinasePhos2.0 [0-1], If higher chance the site is phosphorylated by the stated kinase, then 

a score close to 1.0. If lower chance of the site phosphorylated by the 
given kinase, then a score close to 0.0. 

Specificity: 80%; 

Serine and Threonine 
Kinase Selected 

All 

GPS2.1 If higher chance the site is phosphorylated by the stated kinase, then the 

score is greater than cutoff. If lower chance of the site phosphorylated by 
the given kinase, then a score is lower than the cutoff. 

 

High Threshold (~2% 

false positive rate)  

All 

DISPHOS1.3 [0-1], If higher chance the site is phosphorylated by the stated kinase, then 
a score close to 1.0. If lower chance of the site phosphorylated by the 

given kinase, then a score close to 0.0. Sites with scores above 0.5 are 
considered significant. 

Default Predictor All 

 

Tool Scoring Method        Settings Selected Known Sites Predicted 
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Table 4: Prediction Summary of Phosphorylation Sites Obtained Using Tools Stated in Table 3 

Site GPS KinasePhos2.0 NetPhos2.0 NetphosK1.0 Disphos1.3 

 Kinase Score Cutoff Kinase Score         Score Kinase  Score Score 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

* Significant scores within each tool are bolded. Sites with at least 3 significant scores are also bolded. 

 

147, S  CAMK/CAMK2/CAMK2a  4 2.917 ATM,Aurora, 0.936339 0.995 PKG 0.56 0.795 

    CKII  0.936339  PKA 0.67  

    
   CKII 0.51  

       PKA 0.65  
 

140, S  Other/AUR/IPL1-yeast  6.684 6.211 Aurora  0.965903 0.14 cdc2 0.55 0.557 

223, S  CMGC/MAPK/p38/MAPK12  11.667 10.667 ATM  0.922071 0.711 GSK3 0.5 0.252 
 CMGC/MAPK/p38/MAPK11  9.333 8    cdk5 0.51  

 CMGC/GSK/GSK3A  6.167 4       

 CMGC/CDK/CDK4/CDK4  5.077 5       
 CMGC/CDK/CDC2/CDC2  4.194 4.072       

 CMGC/CDK  2.949 2.856       

91, S  STE/STE7/MAP2K1  8 7 ATM  0.851752 0.976 CKI 0.57 0.52 

 Atypical/PIKK/DNAPK   4.048 2.952       

 AGC/RSK/RSK/RSK2  4 3.333       

 AGC/GRK/GRK/GRK-5  2.455 2.273       
384, S CAMK/MLCK  7.667 5.5 ATM,PLK1  0.817356 0.02   0.115 

252, S  TKL//ILK  7.556 3.556 ATM  0.936008 0.008 PKC 0.72 0.191 

 TKL//ILK  2.938 1.938 PKB  0.875034     

77, S  CAMK/CAMK1/CAMK4  7.4 6.5 ATM  0.959036 0.978 RSK 0.59 0.787 

 AGC/RSK/p70  7.25 6.083       

 AGC/SGK  6.55 6.05       
 CAMK/MAPKAPK/MAPKAPK  6.364 6.03       

 CAMK/CAMK1/CAMK1a/ 

CHK1  

5 5       

 Other/CKII  4.604 4.5       

 CAMK/CAMK2  4.5 4.125       

 CAMK/MAPKAPK  4.083 3.639       
 AGC/AKT  4.022 3.831       

 CAMK/RAD53  3.882 3.176       

 CAMK/CAMK2/CAMK2a  3.444 2.917       
 CK1/CK1/CK1a  2.059 1.588       

 Other/PLK  1.875 1.812       

160, S  CAMK/MLCK  6.667 5.5 ATM  0.936898 0.763 cdc2 0.53 0.58 

244, S  STE/STE-Unique/COT  6.4 6.4 ATM  0.899489 0.037   0.281 

 STE/STE20/PAKA/PAK3  3.5 2       

229, S  Other/Other-Unique/KIS  6 5.2 ATM  0.85651 0.013   0.63 

73, S  Other/IKK/IKKa  5.889 4      0.805 

 AGC/GRK/GRK/GRK-1  3.75 3.75       

 STE/STE20/PAKA/PAK3  2.8 2       
 AGC/PKB/PDK1  2 1.853       

 CK1  1.636 1.455       

 AGC/GRK  0.917 0.798       

94, T  CAMK/CAMK1/CAMK1a  5.25 5 ATM  0.851752 0.937   0.182 

 AGC/PKB  4.294 1.882       

 CAMK/CAMKL  3.118 2.461       

 AGC/PKB/PDK1  2.382 1.853       
 AGC/GRK/BARK  1.97 1.788       

 AGC/GRK/BARK/GRK-2  1.69 1.621       

204, S  Other/AUR/AUR-A  5.071 3.536 CK1  0.82003 0.979 PKG 0.58  

       
PKA 0.54 0.231 

82, S  STE/STE7/MAP2K7  5 3.2 ATM  0.952584 0.086 CKII 0.64 0.613 

705, S  STE/STE-Unique  3.857 2.857 ATM  0.932278 0.967 CKII 0.56 0.182 

 STE/STE20/PAKA/PAK3  2.1 2    PKC 0.7  
95, T  TKL/MLK  2 1.938 CKII  0.852185 0.333   0.339 

 TKL  1.139 0.944       

 AGC/GRK  0.821 0.798       

239, S  AGC/PKC/Iota  3.692 3.692 ATM  0.937521 0.732 PKC 0.76 0.431 

116, S  CMGC/MAPK/ERK/MAPK7  3.214 3.214 Aurora  0.927545 0.132   0.232 
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Table 5: Prediction Summary of Known Phosphorylation Sites Obtained Using Tools in Table 3 

Site GPS KinasePhos2.0 NetPhos2.0 NetphosK1.0 Disphos1.3 

 Kinase Score Cutoff Kinase Score         Score Kinase  Score Score 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

6  Conclusion 

Three dimensional model of a protein is important to understand structural properties and 

the interactions of a protein. This is because amino acids that reside closely in a linear sequence 

do not always localize together upon folding. In this study, the 3D structure of Maize SBEIIb 

was predicted using several modeling techniques. Rice BEI was identified as the main sequence 

and structural homolog of Maize SBEIIb, which has its crystallographic structure determined. 

Across all predicted models of SBEIIb, known phosphoserines and KCRR domain were found 

*Significant scores within each tool are bolded. 

225, S AGC/PKC/Eta/PKCe 10 7.111 PKB 0.929907 0.995 PKA 0.79 0.671 

225, S AGC/GRK/BARK/GRK-3 6 5.75 ATM 0.806231  RSK 0.58  

225, S AGC/PKC/Delta 5.452 3.806 PKA 0.704077     

225, S CAMK/CAMKL/CHK1 5.143 4.571 PKC 0.624169     

225, S CAMK/DAPK/DAPK3 4.944 4.222 CaM 0.617907     

225, S AGC/PKC/Alpha 4.771 4.59 IKK 0.604278     

225, S AGC/PKC/Delta/PKCd 4.217 3.478 RSK 0.530444     

225, S STE/STE20/PAKA 3.345 3.052 STK4 0.512389     

225, S STE 3.24 2.68 CHK1 0.512389     

225, S CAMK/RAD53 3.235 3.176 AKT1 0.505506     

225, S CAMK/DAPK 2.958 2.917 PKG 0.5     

225, S STE/STE20 2.368 2.088 PDK 0.5     

225, S AGC/PKC 2.203 2.201       

236, S Other/CKII/CKIIb 6.5 6.5 ATM 0.974715 0.99 CKII 0.53 0.272 

236, S    GSK-3 0.769668  PKC 0.66  

236, S    MAPK 0.766547  cdc2 0.5  

236, S    CKII 0.756256     

236, S    PKA 0.626297     

236, S    PKC 0.57266     

236, S    PLK1 0.559166     

236, S    RSK 0.532445     

236, S    IKK 0.526149     

236, S    STK4 0.513123     

236, S    CHK1 0.513123     

236, S    PKG 0.505165     

236, S    AKT1 0.5     

588, S AGC/AKT/AKT2 6 5.75 ATM 0.935387 0.995 cdk5 0.61 0.556 

588, S    Aurora 0.627341  RSK 0.54  

588, S    RSK 0.529534  PKC 0.75  

588, S    STK4 0.512632  PKG 0.59  

588, S    CHK1 0.512632     

588, S    CDK 0.505767     

588, S    AKT1 0.505069     

588, S    PKG 0.5     
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localized on surface loops. These will be well hydrated, thus structural perturbations upon 

phosphorylation will likely be minimal.  I-Tasser model without the highly disordered N-

terminus was used for phosphorylation simulations in SHARCNET (www.sharcnet.ca). 

Thousand femtosecond MD simulations on Sybyl-X 1.3, and energy minimization and 

equilibration in GROMACS 4.5.5 did not reveal any observable effects on the structure. Fifty 

nanosecond MD simulation results from GROMACS 4.5.5 are in progress.  

Across phosphorylation site prediction tools, the three known phosphoserines obtained 

significant scores. However, the scores were not consistent for certain predicted sites and 

kinases. Phosphorylation site predictions identified S160 as a probable candidate. Additionally, 

CKII and ATM were predicted as possible kinase candidates.  

 Future work should focus on carrying out simulations longer than 1000 fs, with explicit 

solvation and global energy minimization in Sybyl-X 1.3. After analyzing GROMACS 4.5.5 

results, longer simulations may be carried out as appropriate. Findings from this study should 

only be treated as predictions, which need to be validated using laboratory studies. 
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8 List of Abbreviations 

3D = Three-Dimensional 

ABC1K = ABC-1 Like Kinase  

ae
-
 = amylose extender mutant 

AGPase = ADP-glucose Pyrophosphorylase 

ASN = Asparagine 

AtK = A.thaliana Kinase 

ATM  = Ataxia Telangiectasia Mutated 

BE = Branching Enzyme 

CAMK = Calcium/Calmodulin-Dependent Protein Kinase 

CASP = Critical Assessment of Techniques for Protein Structure Prediction 

CK = Casein Kinase  

DAP = Days After Pollination 

DBE = Debranching Enzymes 

DISPHOS = DISorder‐enhanced PHOSphorylation predictor      

EBI = European Bioinformatics Institute  

FAO = Food and Agriculture Organization 

GLN = Glutamine  

GPS = Group-based Prediction System  

GSK = Glycogen Synthase Kinase    

GST = Glutathione S-Transferase   

ISA = Isoamylases     

I-TASSER = Iterated -Threading ASSEmbly Refinement program 

Locally minimized-MD = Local and Torsion Minimization, followed by Molecular Dynamics 

K = Lysine  

MD = Molecular Dynamics  

M = Methionine  

NCBI = National Centre for Biotechnology Information 

PDB = Protein Data Bank 

PKA = Protein Kinase A 

PKC = Protein Kinase C    

PKG = Protein Kinase G    

PPK = Polyphosphate Kinase     

pS286 = phosphorylated Serine 286   

pS297 = phosphorylated Serine 297 

R = Arginine     

S = Serine    

S/BE = Starch/ Branching Enzyme   

SNF = Sucrose-Non-Fermenting    

SnRK1 = SNF1-Related Protein Kinase   

SP = Starch Phosphorylase   

SS = Starch Synthase    

SVM = Support Vector Machines    

T = Threonine    

TAIR = The Arabidopsis Information Resource    

VMD = Visual Molecular Dynamics  
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9 Appendix 
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3AMK Rice BEI identified by 

Noguchi et al., 2011                                                                                                         

3AML Rice BEI identified by 

Noguchi et al., 2011                                                                                                         

Structures of Rice BEI 
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Alignment between 3AMK (Rice BEI) and Maize SBEIIb 
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Maize SBEIIb Homologs Alignment Using MAFFT 
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Maize SBEIIb Homologs Alignment Using MAFFT, continue…. 
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Maize SBEIIb Structural Analogs Alignment Using MAFFT 
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Maize SBEIIb Structural Analogs Alignment Using MAFFT, continue…. 
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Maize SBEIIb Structural Analogs Alignment Using MAFFT, continue…. 
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Top 10 Structural Analogs of Maize SBEIIb Identified using TM-Align 

Program  

Note: Refer Table 2 for the full names of the PDB accessions below each structure 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3amlA 3k1dA 

1m7xB 2ya0A 

2ya1A 3fawA 
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Top 10 Structural Analogs of Maize SBEIIb Identified using TM-Align 

Program, continue…. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1bf2A 2vr5B 

2x4bA 2fhbA 
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Appendix B 

Command Log for Sybyl-X 1.3 Analysis of Maize SBEIIb on Biopolymer and 

Phosphorylation 

Used: Biopolymer Manual as a Guide 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Phosphorylation of Serine 

  

 

 

 

 

 

 

 

 

 

File > Import File> MaizeSBEIIb  # to open the file  

Biopolymer > Prepare Structure > Structure Preparation Tool# to analyze the protein 

Press Analyze Selected Structure 

Repair Sidechain Fix # residue missing in the side chains; None were present 

Termini Treatment Fix # chain termini that need fixing or modification; 2 were present: GLU683, ASP1; These 

were fixed by selecting ‘Neutral’ under New Block 

*Add Hydrogens # add hydrogens to residues without hydrogen;  *683 residues need to be added with 

hydrogens 

*Which Hydrogens do you want to add? All/ Essential 

*Hydrogen orientation in water? Random/ H-bonding 

**This step was omitted for GROMACS, as GROMACS adds its own hydrogens 

Fix Sidechain Amides # Orient the sidechain amides in all ASN and GLN residues to maximize hydrogen 

bonding;  Reversed amide side chain of GLN3, GLN7, ASN83, GLN138, ASN188, ASN207, ASN350, ASN540, 

ASN542, ASN586 for SBEIIb 

File>Export File> Save As PDB> Format PDB V3.1 

 

File > Import File> MaizeSBEIIbanalyzed 

Biopolymer > Build > Phosphorylate 

OPEN sequence Viewer>select amino acid; Selection Tab>Colour>select colour 

Phosphorylation Options> Indicate the protonation state (-1,-2)  
*set to -2 O-P02-O (as opposed to O-PO2-OH) 

SELECT ‘Apply Amber types and charges’ (default) 

File>Export File> Save As PDB> Format PDB V3.1 
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Before (A) and after (B) phosphorylation of S286 (indicated in pink) on Sybyl 

A B 

Before (C) and after (D) phosphorylation of S297 (indicated in yellow) on Sybyl 

Before (E) and after (F) phosphorylation of S286 + 297 (indicated in pink and 

yellow, respectively) on Sybyl 

C D 

F E 

Sybyl-X 1.3 Phosphorylation of S286 and S297 
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Command Log for Sybyl-X 1.3 Simulations of Doubly Phosphorylated Model 

Used: Force Field Manual As a Guide 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Local Energy 

Minimization 

Compute > Total Energy 
Molecule currently has Dictionary charges. 
Total Charge =  -22.855 
 
Computer> Energy (Select Amber 99 as Force field, and AMBER as charges) 
Energy for molecule : FinalMaizeSBEIIbttsa 
 
            Bond Stretching Energy : 1161.686 
              Angle Bending Energy : 2541.734 
                  Torsional Energy : 1892.255 
         Improper Torsional Energy :   78.533 
          1-4 van der Waals Energy : 4355.710 
              van der Waals Energy : 1618435081.896 
          1-4 Electrostatic Energy : 6033.625 
              Electrostatic Energy : -15475.486 
                    ========================= 
                      Total Energy : 1618435669.953 kcals/mol 
 
Avg. Number of van der Waals + electrostatic pairs = 2898954 
Avg. Number of 1-4 van der Waals + electrostatic pairs = 28328 
Avg. Number of scaled van der Waals + electrostatic pairs = 127785 
 
                             Number     CPU Time (secs)         % of Total 
    Non Bonded Rebuilds          1               1.29              86.45 
    Energy Evaluations               1               0.20              13.55 
    Total CPU time (secs) =       1.50 
 
Compute>Minimize>Subset> S297+286  
Compute> Energy 
Energy for molecule : FinalMaizeSBEIIbttsa 
 
   Energy in aggregates 
            Bond Stretching Energy :  999.061 
              Angle Bending Energy : 2304.307 
                  Torsional Energy : 1694.924 
         Improper Torsional Energy :   70.721 
          1-4 van der Waals Energy : 3906.839 
              van der Waals Energy : 203569.033 
          1-4 Electrostatic Energy : 5477.842 
              Electrostatic Energy : -13783.355 
                    ========================= 
       Total Energy in Aggregates  : 204239.372 kcals/mol 
 
            Bond Stretching Energy :   39.623 
              Angle Bending Energy :  208.470 
                  Torsional Energy :  255.792 
         Improper Torsional Energy :   22.115 
          1-4 van der Waals Energy :  308.497 
              van der Waals Energy : -422.805 
          1-4 Electrostatic Energy :  519.815 
              Electrostatic Energy : -1896.406 
                    ========================= 
                      Total Energy : 203274.473 kcals/mol 
 
Avg. Number of van der Waals + electrostatic pairs = 465438 
Avg. Number of 1-4 van der Waals + electrostatic pairs = 2591 
Avg. Number of scaled van der Waals + electrostatic pairs = 21301 
 
                             Number     CPU Time (secs)         % of Total 
    Non Bonded Rebuilds          1               0.36              88.40 
    Energy Evaluations               1               0.05              11.60 
    Total CPU time (secs) =       0.41 

Initial Energy 
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Command Log for Sybyl-X 1.3 for Simulating Doubly Phosphorylated Model, 

continue…. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Torsion 

Minimization 

+  Molecular 

Dynamics 

 
 Compute>Minimize>Torsion 
 Compute>Dynamics Setup  # at 25C (298.15 K) 
Compute>Energy 
Energy for molecule : FinalMaizeSBEIIbttsa 
 
   Energy in aggregates 
            Bond Stretching Energy :  999.084 
              Angle Bending Energy : 2304.310 
                  Torsional Energy : 1750.199 
         Improper Torsional Energy :   70.720 
          1-4 van der Waals Energy : 3947.423 
              van der Waals Energy : 16904.433 
          1-4 Electrostatic Energy : 5469.125 
              Electrostatic Energy : -13819.688 
                    ========================= 
       Total Energy in Aggregates  : 17625.606 kcals/mol 
 
            Bond Stretching Energy :  219.735 
              Angle Bending Energy :  516.940 
                  Torsional Energy :  326.290 
         Improper Torsional Energy :   42.545 
          1-4 van der Waals Energy :  333.612 
              van der Waals Energy : -486.192 
          1-4 Electrostatic Energy :  526.779 
              Electrostatic Energy : -2084.882 
                    ========================= 
                      Total Energy : 17020.433 kcals/mol 
 
Avg. Number of van der Waals + electrostatic pairs = 452904 
Avg. Number of 1-4 van der Waals + electrostatic pairs = 2591 
Avg. Number of scaled van der Waals + electrostatic pairs = 20677 
 
                             Number     CPU Time (secs)         % of Total 
    Non Bonded Rebuilds          1               0.39              86.28 
    Energy Evaluations           1               0.06              13.72 
 
      Total CPU time (secs) =       0.45 
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Appendix C 

GROMACS 4.5.5 Log for Doubly Phosphorylated Model 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

#construction of the double phosphorylated_S286_S297 Maize SBEII obtained from threading analysis 
Step 1: Write coordinate file (generate .gro file) 
pdb2gmx -f 4FinalMaizeSBEIIbttsaSp286_Sp297.pdb -o 4FinalMaizeSBEIIbttsaSp286_Sp297.gro -p 
4FinalMaizeSBEIIbttsaSp286_Sp297.top -ter -ignh 
Termini selection was uncharched for both N and C-termini and we ignored hydrogens attached to carbons 
Number of bonds was 7460, now 7455 
Generating angles, dihedrals and pairs... 
Before cleaning: 11286 pairs 
Before cleaning: 14544 dihedrals 
There are 3704 dihedrals, 4054 impropers, 10965 angles 
11286 pairs,     7455 bonds and     0 virtual sites 
Total mass 78893.631 a.m.u. 
Total charge -26.000 e 
 
#Step 2:  we use editconf to create the simulation box. This box is cubic and the protein is 1nm from the edge and centered. 
editconf -f 4FinalMaizeSBEIIbttsaSp286_Sp297.gro -o 4FinalMaizeSBEIIbttsaSp286_Sp297_box.gro -c -d 1.0 -bt cubic 
 
Read 7278 atoms 
Volume: 406.357 nm^3, corresponds to roughly 182800 electrons 
No velocities found 
    system size :  6.106  8.363  7.958 (nm) 
    diameter    :  9.514               (nm) 
    center      : -0.166 -0.068  0.001 (nm) 
    box vectors :  6.106  8.363  7.957 (nm) 
    box angles  :  90.00  90.00  90.00 (degrees) 
    box volume  : 406.36               (nm^3) 
    shift       :  5.923  5.825  5.756 (nm) 
new center      :  5.757  5.757  5.757 (nm) 
new box vectors : 11.514 11.514 11.514 (nm) 
new box angles  :  90.00  90.00  90.00 (degrees) 
new box volume  :1526.60               (nm^3) 
 
#Step 3: We fill box with water using water model SPC 216. 
genbox -cp 4FinalMaizeSBEIIbttsaSp286_Sp297_box.gro -cs spc216.gro  -p 4FinalMaizeSBEIIbttsaSp286_Sp297.top -o 
4FinalMaizeSBEIIbttsaSp286_Sp297_S_box.gro 
 
Output configuration contains 149883 atoms in 48218 residues 
Volume                 :      1526.6 (nm^3) 
Density                :     1037.39 (g/l) 
Number of SOL molecules:  47535    
 
#Step 4: We prepare or simulation system for genion 
grompp -f ions.mdp -c 4FinalMaizeSBEIIbttsaSp286_Sp297_S_box.gro -p 4FinalMaizeSBEIIbttsaSp286_Sp297.top  -o 
4FinalMaizeSBEIIbttsaSp286_Sp297_ions.tpr 
 
#Step 5: We use genion to add salt and neutralize system 
genion -s 4FinalMaizeSBEIIbttsaSp286_Sp297_ions.tpr -o 4FinalMaizeSBEIIbttsaSp286_Sp297_ions_neutral.gro -p 
4FinalMaizeSBEIIbttsaSp286_Sp297.top -pname NA -np 164 -nname CL -nn 138 
 
*Processing topology (gromacs terminal output)* 
Replacing 47233 solute molecules in topology file (4FinalMaizeSBEIIbttsaSp286_Sp297.top)  by 164 NA and 138 CL ions. 
 
*From top file*: 
[ molecules ] 
; Compound        #mols 
Protein_A           1 
SOL         47233 
NA          164 
CL          138 
 
NB. We have to rename NA and CL in our .top file to NA+ and CL- respectively 

 



44 

 

 

GROMACS Log for Doubly Phosphorylated Model, continue…. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
#Step 6: We prepare our system for energy minimization. 
grompp -f ions.mdp -c 4FinalMaizeSBEIIbttsaSp286_Sp297_ions_neutral.gro -p 4FinalMaizeSBEIIbttsaSp286_Sp297.top  -o 
4FinalMaizeSBEIIbttsaSp286_Sp297_EM.tpr 
 
#Step 7: we run energy minimization 
mdrun -v -s 4FinalMaizeSBEIIbttsaSp286_Sp297_EM.tpr -deffnm 4FinalMaizeSBEIIbttsaSp286_Sp297_EM 
 
#Below is gromacs output for energy minimization once complete: 
Steepest Descents converged to Fmax < 1000 in 1677 steps 
Potential Energy  = -2.5375722e+06 
Maximum force     =  8.4248083e+02 on atom 1801 
Norm of force     =  1.5795526e+01 
 
#Step 8. We make index file in order to do our equilibration steps 
make_ndx -f 4FinalMaizeSBEIIbttsaSp286_Sp297_EM.gro -o index.ndx 
 
*merged protein group with SEP using "1|12" to create Protein_SEP and also merged SOL with NA+ and CL- to get 
SOL_NA+_CL- and then saved to create .ndx file* 
 
#Step 9. Run Grompp to assemble files needed for NVT equilibration: 
grompp -f nvt.mdp -c 4FinalMaizeSBEIIbttsaSp286_Sp297_EM.gro -n index.ndx -p 4FinalMaizeSBEIIbttsaSp286_Sp297.top -
o 4NVT.tpr 
* note that it is important to specify the coupled groups in the .mdp file. In this case it is Protein_SEP and SOL_NA+_CL- 
 
Step 10. Run the actual command for NVT equilibration: 
mdrun -v -s 4NVT.tpr -deffnm 4FinalMaizeSBEIIb_NVT 
 
#Step 11. Run Grompp to assemble files needed for NPT equilibration 
grompp -f npt.mdp -c 4FinalMaizeSBEIIb_NVT.gro -n index.ndx -p 4FinalMaizeSBEIIbttsaSp286_Sp297.top -o 4NPT.tpr 
 
#Step 12. Run the actual command for NPT equlibration 
mdrun -v -s 4NPT.tpr -deffnm 4FinalMaizeSBEIIb_NPT 
grompp -f ../mdonly_160ns.mdp -p S_2715_5849.top -c S_2715_5849_EM.gro -o S_2715_5849_md.tpr 
 
 
 
 
#Need to be run 
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GROMACS Solvated Box 

 

Protein, Maize SBEIIb, shown in the middle in blue colour, surrounded by water and ion (Na+ 

and Cl-) molecules.  


